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1. Introduction 
 
This guide follows on from the Endnote guide. It demonstrates how to use more 
advanced features of Endnote such as deduplication, editing referencing styles, 
backing up your library and merging libraries. It will be particularly useful if you 
have a large number of references, a complex piece of work or are collaborating 
with others. 
 
 
 

2. Sorting records 
 
To change the order your records are displayed in click on a column heading, click 
on the Author column to change Author sort from ascending to descending. Click the 
Year column to see references in descending order based on year of publication. 
Click the Read/Unread column to sort with either read or unread items at the top. 
 

 
 
 
 

3. Finding duplicates 
 
If you are importing references from a number of different sources you may have 
duplicate references in your library. Endnote can help remove duplicates. 

 
Go to References menu and select Find Duplicates. If any duplicates are 
found they will appear side by side so you can select which to keep. 
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To change how Endnote finds duplicates go to the Edit menu and select 
Preferences then Duplicates as below. To make sure that most duplicates 
are found change the fields which are being checked and use different 

combinations. This is especially useful if you are doing a literature or systematic 
review. 
 

 
 
To ensure you are removing all duplicates e.g. for a systematic review start by 
selecting Author, Year and Title. To remove any false duplicates found hold Ctrl 
and select the false duplicate. Once you are happy that all are duplicate articles, 
drag the selected results to the trash. Next select Author and Title and repeat the 
above process. Next, select Year and Title, then Author, Year and Volume. If you 
still have duplicates, you can repeat this process with different combinations. Keep 
all the duplicates in the trash. 
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4. Adding and editing a referencing style 
 
If the referencing style you require is not there it is possible to add your own or edit 
an existing style. 
 
 

In Endnote go to the Edit menu - Output Styles - New Style for a new 
referencing style or Open Style Manager to edit a style. 
 

 
Once in Style Manager select the style you would like to edit, select Edit and the 
fields you would like to change e.g. Page Numbers. 
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5. Editing citations in Word 
 
If you don’t want to edit the style as above in Section 4, it is possible to edit individual 
references in Word. This can be useful if you want to add page numbers to a 
reference, e.g. “(Jones 2014, p15) argues …” 
 
 

 
Highlight the citation and select Edit & 
Manage Citation(s) from the Citations box in 
the Endnote tab. 
 
 

 
 
 

Page numbers are added in 
the Suffix box. You may 
need to precede the p. with 
a comma so that there is a 
gap between the year and 
page numbers). These 
changes will be saved even 
if you Update Citations and 
Bibliography.  
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6. Inserting citations into PowerPoint 
 
To insert a citation and reference into PowerPoint you need to have installed the 
plugin that is also used in Word. 
 

Make sure that you have selected the correct style (e.g. Harvard, Vancouver) 
before inserting a citation or reference. 
 

 
To insert a citation on a slide in the EndNote tab, click Insert Citation and 
search for the required citation and Insert. To insert a reference click Insert 
Reference and search for the required reference. 

 

 
 
 
 

7. Backing up/Creating a copy of your library 
 
As with any other piece of work it is important that you have your Endnote library 
backed up so that you won’t lose your work if your original files are lost or damaged. 
 
 

The easiest way to back up your library is to save it to another device or 
portable storage. The files you need to save are  
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To create a copy of your library go to File – 
Save a Copy and Save. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

8. Changing text 
 
To change the text of a number of references use the Find and Replace function that 
is on the Edit menu. 
 
 
 

9. Importing PDF files 
 

To create a group from a folder of PDF 
files select File – Import – Folder… 
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Browse to find the folder you 
want to import, and tick both 
options to import all the items 
from the folder to a new group. 
The PDFs will appear as a new 
group. 
 
 
 
 
 
 
 

 
Check the references once they are imported as the record may not be as 
complete as one you have downloaded from a database. If you are 
importing scanned PDFs there may be a record created but no data in it as 

Endnote relies of DOIs to source the data and a scanned PDF will not have a DOI. 
 
 
 

10. Document auto group 
 
If you need to check which references you are using in a document you can easily 
do this by opening the document in Word and your Endnote library. 
 
 

In Word in the Endnote tab, click Update Citations and Bibliography.    
 

 
 

 
 
 

 
The document auto group will appear in your 
Endnote library. This group is temporary and will 
disappear when you close the Word document. 
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11. Merging libraries 
 
To merge two Endnote libraries together: 

Open the library you want to copy or merge documents into. 
Select File – Import – File. 
Select the Endnote library you wish to merge into your main library and 

select Endnote library from the list of import options. 

 
 

 
It is possible to Import All, Discard Duplicates, or Import into Duplicates 
Library. This last option creates a new library for the duplicate records. 
 

 
You can also copy and paste references from one library to another. 
 
 
 

12. Move text with citations 
 
To move text around within a Word document it is possible to cut and paste as 
usual. 
 
 
To move text and citations to a different document: 

Select the text you want to move to a new document. 
In the Endnote tab, click Convert Citations and Bibliography - Convert to 
Unformatted Citations. 
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Paste your selected text into your new Word document and click Update 
Citations and Bibliography. 
Your citations will be formatted in your new document in the selected style 

and Endnote will create a bibliography at the end of your document. 
 
 
 

13. Storing charts, tables or equations 
 

To create an Endnote reference for tables, charts or equations they must 
first be saved as images. 
 

 
To save the reference to Endnote 
Select References – New Reference 
Change the reference type from Journal article to Chart or Table, Equation, 

or Figure. 
Add some information to the fields e.g. Title, caption 

Click on the Attach Figure button.  

 
 
Browse to find the correct image and click on the Open button. 
 
 
 

14. Travelling library 
 
When citations are added to a document, a travelling library is created. From these 
references, it is possible to create a new library or add these references to an 
existing library. 
 
 

In Word, in the Endnote Tab select Export to Endnote - Export Travelling 
Library 
 

 

 
 
 
You are given the choice of adding the references to an existing library or creating 
a new one. 
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A travelling library is not the same as linking your EndNote web library to 
Endnote. The travelling library is simply the references from a single Word 
document. If you want to add references while you are away from your 

Endnote desktop library, you can find how to do this in our “Managing references & 
bibliographies using Endnote” guide. 
 
 
 

15. Create a bibliography from a group 
 
It is possible to create a bibliography from a group of references. 
 
 
 

In Endnote, select the referencing style required. (If the style you require 
isn’t on the list select Find Another Style and search for it in the list). 

 
 
Select the group you want to use. To copy all the references use Ctrl + A to 
highlight them all or use Ctrl and the left mouse button to select the required 
references. 
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Right-click on the selected references and select Copy Formatted from the menu. 

 
Paste the references into a document. 
 
 
 

16. Custom fields 
 
If you are working on updating a previous piece of work, how do you find items that 
were included in the earlier version? If you are collaborating on a systematic review 
with another reviewer how can you see where you agree and disagree? 
 
 
Using custom fields will help with both these issues. 
 
 

To edit a custom field go to Tools - Change/Move/Copy 
This can be done with the records chosen by Reviewer 1 selected in 
Endnote – they could be placed in their own group. 
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Select the field you want 
to change e.g. Custom 
1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
Import the records chosen by Reviewer 2 and place them into their own group. 
While the records are selected edit Custom 2 as above to Reviewer 2. 
 
Now create a Smart Group “Custom 1 contains Reviewer 1 or Custom 2 contains 
Reviewer 2” 
 
Now find duplicates as explained in Section 2 on p2. Remove the duplicate and the 
original and you should just be left with the items chosen by Reviewer 1 or 
Reviewer 2. 
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17. Exporting your Endnote library to another 
reference manager 

 
Do this if you need to export your library to another reference manager or to send 
to a colleague. 
 

Highlight the references you want to export. (If you want to export all you can 
do by selecting All References, Edit – Select All) 
 

Then File - Export. 
 

 
 
Make sure you choose an output style that is compatible with the place that you 
are sending them, e.g. RIS for another reference manager. If the style you want 
isn’t there you can Select Another Style and choose from the list of options. 
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18. Exporting References to Excel or Access 
 

Before beginning the export process create a backup copy of your Endnote 
Library as in Section 7 so that the changes you make will not affect your 
original library. 

 
To export to Excel we first need to create a new reference style as in Section 4. 
Make sure that you create a style for each reference type e.g. book, journal article 
and include all the fields you need e.g. author, title, journal title, volume number 
etc. 
 

Go to Edit – Output Styles, select a new style, and go to 
Bibliography – Templates in the list on the left of the screen. 
 
 
 
 
 
 
 
 
 
 
 

 
Next, select the reference type you 
want e.g. journal article and select 
the fields you want to appear by 
clicking on Insert Field on the right of 
the screen and selecting from the 
list. Make sure you put a tab 
between the fields, this appears in 
the Insert Field list near the top.  
 
Select how you would like the 
author’s name to appear by clicking 
on the Author Name option, which 
appears under the Bibliography 
option and is highlighted in the 
image above. 
 
Remember to save the style once 
you have created it. 
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Now we need to remove the carriage returns by using the Edit – Find & replace 
function. Find Carriage return by using the Insert Special menu and selecting 
Carriage return option. Replace it with “;”. You are now ready to export your library 
to Excel. 
 

 
 

To export follow the instructions in section 17 but make sure the output 
style is the one you saved earlier. Save the file to your desktop. 
 

 
In Excel go to Open Other Workbooks and Browse find your file on the 
desktop, you might have to change the All Excel Files to Text Files to find 
your library. Select Open once you have found your file. The options in the 

Excel Import Wizard should be Delimited on the first screen, Tab on the second 
and General on the third. Your library should now open with all the references 
arranged in the appropriate columns. 
 
 
 

19. Sharing your Endnote library 
 

In Endnote it is possible to share your library with up to 100 others without 
having to export it as a file. To share your library you need to be using 
version 7.2X or later and have an Endnote online account. 

 
 

Before you can share your library you must make sure that it is fully 
synchronised. (There are instructions on how to do this in the “Managing 
references & bibliographies using Endnote” guide.) 
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To share your library go to the File menu and select Share… or click  . 
Enter the email addresses of the people you would like to share with. They 

will then receive an email with instructions. 
 
In version X8 it is possible to see an activity feed of changes being made to the 

shared library by clicking.  
 

Once you have shared your library you should regularly make backups of 
the library as anyone you have shared it with can make changes. 
 

 
 

20. Help and Training 
Free training on how to search databases and is available from any NHS  
Library in the East of England. 
 
For further help, or to arrange a training session in Addenbrooke’s, please contact: 
 
Isla Kuhn, Eleanor Barker, or Veronica Phillips 
University of Cambridge Medical Library 
 
Email : librarytraining@medschl.cam.ac.uk 
Phone : (01223) 336750 
Web : http://library.medschl.cam.ac.uk   
 

http://library.medschl.cam.ac.uk/

